Welcome to the ENTITI Platform - Your Doorway to AR + VR!

The ENTITI Platform enables anyone to create interactive and dynamic Augmented Reality (AR) and Virtual Reality (VR) content without any programming or graphic app experience. ENTITI Creator is both simple enough to enable anyone to enhance their audience’s visual experience and sophisticated enough for professional designers.

About This User Guide

This user guide contains the following chapters:

- **Chapter 1, Introducing the ENTITI Platform**, page 5, introduces Augmented Reality (AR) and Virtual Reality (VR) ENTITIs and the ENTITI platform that enables you to create and enjoy them. This chapter also provides a comprehensive reference to all the tasks that you can perform in the ENTITI Platform.

- **Chapter 2, Tutorials**, page 14, provides two simple tutorials (one Augmented Reality and one Virtual Reality) that get you up and running quickly and demonstrate some of the basic features of the ENTITI Platform.

- **Chapter 3, Getting Started**, page 31, describes how to get started using the ENTITI Platform and describes some of its common user interface features.

- **Chapter 4, ENTITI Creator Library**, page 46, describes how to use the ENTITI Creator Library to upload assets into the ENTITI Platform.

- **Chapter 5, ENTITI Creator Scene**, page 56, describes how to use the ENTITI Creator Scene window to add, scale, position and rotate the assets in your ENTITI scene and to define their properties.

- **Chapter 6, ENTITI Creator Logic**, page 93, describes how to add advanced app-like interactivity, even to a level of games by just dragging and dropping.

- **Chapter 7, Basic Concepts**, page 121, describes a few concepts that may help non-experienced users understand basic 3D terminology.
# Table of Contents

Chapter 1, Introducing the ENTITI Platform ....................................... 5  
  Introduction ........................................................................................................... 5  
  ENTITI Components .............................................................................................. 6  
  Augmented Reality (AR) ......................................................................................... 8  
  Virtual Reality (VR) ................................................................................................. 10  
  ENTITI Creation Workflow ...................................................................................... 12  
  Quick Reference ..................................................................................................... 13  

Chapter 2: Tutorials ........................................................................... 14  
  Augmented Reality (AR) Tutorial .......................................................................... 15  
  Virtual Reality (VR) Tutorial .................................................................................. 23  

Chapter 3: Getting Started ........................................................... 31  
  Planning Your ENTITI ............................................................................................. 33  
  Creating an ENTITI .................................................................................................. 33  
  ENTITI Creator Menubar ......................................................................................... 37  
  Saving and Publishing an ENTITI ............................................................................ 44  
  Viewing an ENTITI without Publishing .................................................................. 45  

Chapter 4: ENTITI Creator Library ................................................. 46  
  Introducing the ENTITI Library .............................................................................. 46  
  Asset Types ............................................................................................................. 47  
  Previewing Library Assets ....................................................................................... 48  
  Uploading Assets into the Library .......................................................................... 48  
  Organizing Asset Folders ....................................................................................... 50  
  Asset Format Guidelines ......................................................................................... 51  

Chapter 5: ENTITI Creator Scene .................................................. 56  
  Scene Window - Quick Tour .................................................................................... 57  
  Overview - Adding Assets to a Scene .................................................................... 59  
  Opening a Scene ...................................................................................................... 60  
  Adding a Placeholder to a Scene ............................................................................ 63  
  Assigning an Asset to a Placeholder ...................................................................... 64  
  Adding an Image ...................................................................................................... 68  
  Adding a Video ......................................................................................................... 75  
  Adding Sound .......................................................................................................... 76  
  Adding Text ............................................................................................................. 79  
  Adding a 3D Model .................................................................................................. 81  
  Adding Light ............................................................................................................ 84  
  Setting the Camera's First View ............................................................................. 85  
  Adding Animation ................................................................................................... 86  
  Advanced Scene Options ....................................................................................... 90
Chapter 6: ENTiTi Creator Logic ................................................... 93
  Introducing ENTiTi Logic .......................................................... 93
  ENTiTi Logic Window – Quick Tour ......................................... 94
  Defining ENTiTi Logic .............................................................. 98

Chapter 7: Basic Concepts......................................................... 121
  Augmented Reality ................................................................. 121
  Virtual Reality ......................................................................... 121
  Digital 3D Space ..................................................................... 121

Important Notice

Copyright © 2016 WakingApp Ltd. All rights reserved.

ENTiTi™, ENTiTi Creator™ and ENTiTi Viewer™ are trademarks of WakingApp Ltd.

All intellectual property rights in this publication are owned by WakingApp Ltd. and protected by applicable copyright laws and international treaty provisions. WakingApp Ltd. retains all rights not expressly granted. No part of this publication may be reproduced in any form whatsoever or used to make any derivative work without prior written approval by WakingApp Ltd.

All other trademarks are the property of their respective owners. Other company and brand products and service names are trademarks or registered trademarks of their respective holders.
Introducing the ENTITI Platform

This chapter introduces Augmented Reality (AR) and Virtual Reality (VR) ENTITIs and the ENTITI Platform that enables you to create and enjoy them. This chapter also provides a comprehensive reference to all the tasks that you can perform in the ENTITI Platform. This chapter contains the following sections:

- **Introduction**, page 5
- **ENTITI Components**, page 6
- **Augmented Reality**, page 8
- **Virtual Reality**, page 10
- **ENTITI Creation Workflow**, page 12
- **Quick Reference**, page 13

**Introduction**

ENTITI is an innovative platform for creating augmented and virtual reality that enables anyone to create interactive and dynamic content within minutes without any development experience.

The ENTITI Creator enables you to fill app-like ENTITIs with your own content and logic. Each ENTITI can be comprised of videos, images, audio, text, 3D models and animation that play out and react according to your design.

Each ENTITI contains all the design elements and logic commands that run it and is completely cloud-based, dynamic and flexible. A rich variety of dynamic ENTITI runtime behaviors can be designed without any code or programming. Each ENTITI can be updated at any time and can be published for immediate availability on mobile devices and smart glasses.
**ENTiTi Components**

The ENTiTi solution is comprised of the following components:

- **ENTiTi Creator™**, page 6
- **ENTiTi Viewer™**, page 7

**ENTiTi Creator™**

ENTiTi Creator is a simple to use computer-based authoring tool (for Windows and MAC OS) for creating your own ENTiTiS that can be easily downloaded from the wakingapp.com website.

For an introduction to the ENTiTi Creator, you may refer to **Chapter 3, Getting Started** on page 31.

For a description of how to use the ENTiTi Creator, you may refer to:

- **Chapter 4, ENTiTi Creator Library**, page 46
- **Chapter 5, ENTiTi Creator Scene**, page 56
- **Chapter 6, ENTiTi Creator Logic**, page 93
The ENTITi Viewer application enables your audience to view AR or VR ENTITis on their mobile devices. The ENTITi Viewer is freely downloadable from the App Store, Google Play and will soon also be available in various VR markets.

The ENTITi Viewer enables you to use any popular mobile device to view:

- **Augmented Reality (AR):** By activating added layers of digital and interactive content on specific image targets (such as to a package label, poster, article and so on), in order to increase engagement with your target audience.

- **Virtual Reality (VR):** By creating a new immersive 3D virtual world using your mobile phone in Cardboard goggles.

You may refer to Chapter 2, Tutorials on page 14 for an introduction to the ENTITi Viewer and a description of how it is used to show AR/VR ENTITis.
Augmented Reality (AR)

What Is AR?

Augmented Reality (AR) enables users to experience the world as it is in real time, but with added layers of digital and interactive content that enhance users’ current perception of reality. This means that users see a live view of a physical real-world environment whose elements are augmented by computer-generated sensory input, such as videos, images, audio files, text and 3D models.

What Is an AR ENTITI?

An AR ENTITI runs in the ENTITI Viewer on an iOS or Android mobile device. The ENTITI Viewer enables end users to see an image target through the mobile device’s camera overlaid with added graphic layers, such as videos, images, audio files, text, 3D models – all with the sequence and interactive behavior (logic) that you define.

The image target becomes the canvas on which the ENTITI plays and all the digital content in the ENTITI relates to it and moves with it, as long as the camera remains pointed at the image target.

How Do End Users Experience an AR ENTITI?

After an end user downloads the ENTITI Viewer to a mobile device, a list of ENTITIs is displayed.

The user can then either browse the list, search for a specific ENTITI by name or point the camera at a QR barcode and scan it.
The end user can then tap an ENTITi to download it into the mobile device’s memory. The end user can then tap an **Activate** button to activate the ENTITi.

A transparent image is displayed overlaid on the camera view, indicating the image at which the user should point the camera of the mobile device. The ENTITi Viewer starts scanning in order to find this image target.

As soon as ENTITi Viewer identifies the image target, it automatically starts to play the ENTITi’s interactive content overlaid on the real world.

The mobile device can be turned or moved in any direction, as long as the camera is still pointing at the image target.

### How Do You Make an AR ENTITI?

Augmented Reality ENTITis are designed in the ENTITi Creator.

You can start by defining an image target at which the end user points the mobile device in order to activate the relevant ENTITi. This is an optional step.

You can then add any 3D or 2D videos, images, audio files, text, light or 3D models to your ENTITi and define the logic of their behavior and user interaction options.
Virtual Reality (VR)

What Is VR?

Virtual Reality (VR) enables users to experience a totally immersive computer-simulated environment that simulates physical presence in real or imagined worlds. VR can also replicate sensory experiences that include virtual sight, sound and touch.

What is a Virtual Reality ENTiTi?

VR ENTiTis run on iOS or Android Google Cardboard™ goggles. In the near future, ENTiTis will also run on Samsung Gear VR™ and Oculus Rift™ goggles.

How Do End Users Experience a VR ENTiTi?

After an end user downloads the ENTiTi Viewer to a mobile device, a list of ENTiTis is displayed. The user can also search for a specific ENTiTi by name. The user taps an ENTiTi to download it and then taps again to activate it.

By default, two images are displayed – one for each eye. The user then places the mobile phone into the Cardboard goggles and then looks through the goggles in order to enjoy the new immersive 3D virtual world.

Tap the top right corner of the ENTiTi viewer to toggle between a single view (as shown below) that can be viewed on your mobile device or a double view (as shown above) that can be viewed through goggles.
How Do You Make a VR ENTITI?

In ENTITI Creator, creating a VR ENTITI starts with an empty space that you can fill with anything you want, such as videos, images, audio files, text or 3D models.

In ENTITI Creator, the perspective that the end user sees is determined by the position and direction of the camera (which represents the end user’s eyes).

For example, you can place the camera on the back of an eagle, so that the end user can see what the eagle sees. Alternatively, you can put the camera in front of the eagle while it flies, so that the user can look into the face of the eagle while it flies.

ENTITI Creator provides a variety of options for defining the interactive options, behavior and the logic of the ENTITI. A variety of options are also provided for controlling the camera.

**NOTE**

A VR ENTITI only enables you to insert 3D objects, not 2D.
ENTiTi Creation Workflow

Before you get started, it is recommended to read the two tutorials described in Chapter 2, Tutorials on page 14 – one for Augmented Reality and one for Virtual Reality.

The following is an overview of a suggested workflow for creating and publishing an ENTiTi. Each step provides a reference to the page of this user guide that describes it. Many of these steps can be performed in a different order, as you see fit.

1. Downloading and Installing (Page 7 and 18)
2. Planning Your ENTiTi (Page 33)
3. Creating an ENTiTi (Page 33)
4. Uploading Assets (Page 48)
5. Uploading an Image Target (for AR Only) (Page 41)
6. Adding Assets to a Scene (Page 59)
7. Adding Light to a Scene (Page 84)
8. Adding Logic to a Scene (Page 93)
9. Saving and Publishing an ENTiTi (Page 44)
Quick Reference

The following is a quick reference to a variety of ENTiTi platform actions:

General
- ENTiTi Platform, page 5
- ENTiTi Viewer, page 7
- ENTiTi Creator, page 6
- Getting Started, page 31
- Creating an ENTiTi, page 33
- Scene, page 56
- Library, page 46
- Logic, page 93
- Saving an ENTiTi, page 44
- Menubar, page 37

- Publishing an ENTiTi, page 44
- Restoring an ENTiTi, page 38
- Opening a Different ENTiTi, page 33
- Deleting an ENTiTi, page 34
- Logging out, page 37
- Screenshots, page 39
- Image Targets, page 41
- Settings, page 38
- Colors, page 52
- Help, page 43

Getting Started – ENTiTi Creator
- Registering/Signing In, page 18
- Downloading and Installing, page 18
- Launching the ENTiTi Creator, page 18
- Planning Your ENTiTi, page 33
- Creating an ENTiTi, page 33
- Quick Tour of the ENTiTi Creator, page 32
- Using Templates, page 15 and 23

Experiencing an ENTiTi
- Downloading the ENTiTi Viewer, page 7
- Experiencing an AR ENTiTi, page 8
- Experiencing a VR ENTiTi, page 10
- Testing an ENTiTi - Developer Token, page 45

Assets
- Quick Tour - Library Window, page 46
- Guidelines for Preparing Assets, page 51
- Uploading Assets into the Library, page 48
- Quick Tour - Scene Window, page 57
- Adding a Placeholder to the Scene, page 63
- Assigning a Library Asset to a Placeholder, page 65
- Assigning an Asset File to a Placeholder, page 66

- Adding an Asset to a Scene, page 59
- Deleting an Asset, page 27
- Image, page 51
- Video, page 75
- 3D Model, page 81
- Text, page 79
- Sound, page 76
- Light, page 84
- Animation, page 86
- Asset Folder, page 50

Designing a Scene
- Opening a Scene, page 60
- Controlling the Scene, page 61
- Positioning, page 72
- Rotating, page 73

- Scaling, page 74
- Camera, page 85
- Adding Additional Scenes, page 90
- Renaming, page 90

Designing ENTiTi Behavior (Logic)
- Quick Tour - Logic Window, page 94
- Defining Logic, page 98
- Adding Commands, page 99
- Defining Logic Flow, page 104
- Verifying Logic Flow, page 108
- Command List Reference, page 95
- Searching for Commands, page 94
- Copying/Pasting Commands, page 94
- Deleting Commands, page 97
- Zooming In/Out of the Flow Map, page 61

- Flow Map Comments, page 114
- Command Input/Output Parameters, page 109
- ENTiTi Event (Trigger) Commands, page 102
- Variable Commands, page 112
- Timing Commands, page 118
- Clickable Objects, page 71
- Conditions, page 119
- Random Behavior, page 120
- Custom Actions, page 115
This chapter provides two simple tutorials (one Augmented Reality page 15) and one Virtual Reality (page 23). These tutorials will get you up and running quickly and will demonstrate some of the basic features of the ENTiti Platform.

Each tutorial provides a link to a ready-made ENTiti and shows you its features in ENTiti Viewer. Each tutorial then shows you how to create that ENTiti in the ENTiti Creator by inserting your own assets into an ENTiti template.

The processes of creating AR and VR ENTitis are very similar, as shown by the tutorials below.
Augmented Reality (AR) Tutorial

The following shows you a ready-made Augmented Reality ENTiti (page 15) and then describes how to build it (page 18). The ENTiti presented in this tutorial is based on one of the ENTiti Platform’s ready-made templates. ENTiti Platform is provided with a variety of ready-made ENTiti templates into which you can simply drag-and-drop your own assets in order to customize it.

Watching the Augmented Reality Tutorial ENTiti

► To view the tutorial ENTiti on your mobile in the ENTiti Viewer:

1. On your mobile device, download and open the ENTiti Viewer, as described in page 7.

2. Select the Augmented Reality option, as shown above.
3 Print the image target shown below in this user guide onto a piece of paper in color. This will be the canvas on which your Augmented Reality ENTiti will play.

![Image Target](image.jpg)

4 Point the mobile device’s camera at the image target and then tap the **Click to Scan** button, as shown below:

![Mobile Device Screen](mobile_screen.jpg)
The description page of the **My First AR ENTITi** is displayed, as shown below:

5 Tap the icon to download the ENTITi to your mobile device.

6 Tap the icon to activate the ENTITi.

A ball is displayed bouncing between two different photographs.

Notice that as long as the camera is pointed at the target image you can move the mobile device closer and further from the image target and can even rotate the device in various directions while still watching the ENTITi play.
Creating the Augmented Reality Tutorial ENTii

► To create the tutorial ENTii on your computer using ENTii Creator:

1  In the WakingApp.com website, click the Download option to download the ENTii Creator (authoring tool) to your computer:

   FREE DOWNLOAD

   The ENTii Creator icon appears on your desktop.

2  Launch the ENTii Creator to display its LOGIN window, as shown below:

   ![LOGIN window]

3  Login using your ENTii CREATOR account user name and password.

   If you do not have an ENTii CREATOR account, click the Don’t have an account yet? Click here button to register. A page is displayed in which you can add an account, as shown below:
The following displays after you login:

4 To create your first VR project, click the **Create New Project** button. The following displays:
5 In Step 1, select the Augmented reality option.

6 In Step 2, select the My First AR ENTiti template.

7 In Step 3, enter a name for your ENTiti.

8 Click the Create button. The following displays:

9 To replace one of the displayed photographs with your own, double-click on it. The following displays:
10. Browse and select your own PNG or JPG image file. Click the OK button to display that image in the ENTITi.

11. Perform steps 9 and 10 in order to replace the other photograph with your own.

12. [Optional] To change the image target (shown on page 16), double-click on it. The following displays:

- Click the Upload button to select an image file. The newly loaded image is then displayed on the left. For example, as shown below:
To assign this newly uploaded image to the ENTiTi, select the newly loaded image on the left and click the right arrow to move it to the right side of this window, as shown below:

[Optional] Select this new image on the right and click the PREVIEW button to display it in the ENTiTi Creator (and later in ENTiTi Viewer).

13 From the Project menu, select the Save option or click the Save button.

14 From the Project menu, select the Publish option or click the Publish button.

15 You can now watch this updated ENTiTi in the ENTiTi Viewer, as described at the beginning of this tutorial.
Virtual Reality (VR) Tutorial

The following shows you a ready-made Virtual Reality ENTiti (page 23) and then describes how to build it (page 25). The ENTiti presented in this tutorial is based on one of the ENTiti Platform’s ready-made templates. ENTiti Platform is provided with a variety of ready-made ENTiti templates into which you can simply drag-and-drop your own assets in order to customize it.

Watching the Virtual Reality Tutorial ENTiti

► To view the tutorial ENTiti on your mobile in the ENTiti Viewer:

1. On your mobile device, download and open the ENTiti Viewer, as described on page 7.

![ENTiti Viewer](image)

2. Select the **Virtual Reality** option, as shown above.

3. In the **Search** field shown above, type in the name of the template ENTiti of this tutorial, which is: **My First Virtual Reality ENTiti**.
The description page of this VR ENTiti is displayed, as shown below:

4 Tap the icon to download the ENTiti to your mobile device.

5 Tap the icon to activate the ENTiti.

By default, two images are displayed on the ENTiti, one for each lens of your goggles. This view enables you to insert your mobile device into Google Cardboard™ goggles in order to enjoy and immersive experience.

A scene outside the building is displayed. Notice how you can look 360° around to see the entire area.
You can tap the top right corner of the ENTiti viewer to toggle between a single view (as shown below) or a double view (as shown above):

Creating the Virtual Reality Tutorial ENTiti

► To create the tutorial ENTiti on your computer using ENTiti Creator:

1. Download and launch the ENTiti Creator as described on page 18.

The following displays after you login:
2 To create your first VR project, click the **Create New Project** button. The following displays:

3 In **Step 1**, select the **Virtual reality** option.

4 In **Step 2**, select the **My First VR ENTiTi** template.

5 In **Step 3**, enter a name for your ENTiTi.

6 Click the **Create** button. The following displays:
7 To replace one of the image placeholders with your own, double-click on it, as shown below:

The following displays:

Browse and select your own PNG or JPG image file. Click the OK button to display that image in the ENTiTi.

8 Perform step 7 in order to replace the other image placeholder with your own image. Alternatively, you can delete the other placeholder by selecting it and clicking the Delete key.
To replace the video placeholder with your own video, double-click on it, as shown below:

The following displays:

Browse and select your own video file. ENTIti Creator supports MP4, AVI, OGV and MOV (QuickTime) video files of up to 20 MB.

Click the **OK** button to display the first frame of that video in the ENTIti Creator.
10 Define the first view that the end user sees when they enter the VR ENTii by rotating the camera displayed in the center of the scene.

To rotate the camera, click on it to display the Rotate tool, shown below:

Click the Rotate tool to display the following:

Drag any of the colored circles to rotate the camera in that direction.

The Preview area on the bottom right shows the view at which the camera is pointed.
11 From the **Project** menu select the **Save** option or click the ![Save](save.png) button.

12 From the **Project** menu select the **Publish** option or click the ![Publish](publish.png) button.

13 You can now watch this updated ENTIti in the ENTIti Viewer, as described at the beginning of this tutorial.
This chapter describes how to get started using the ENTiTi Platform and describes some of the common user interface features of ENTiTi Creator. This chapter contains the following sections:

- Quick Tour of the ENTiTi Creator User Interface, page 32
- Planning Your ENTiTi, page 33
- Creating an ENTiTi, page 33
- ENTiTi Creator Menubar, page 37
- Saving and Publishing an ENTiTi, page 44
- Viewing an ENTiTi without Publishing, page 45
Quick Tour of the ENTii Creator User Interface

To open the ENTii Creator, refer to the instructions on page 18.

The following provides a quick tour of the main features of the ENTii Creator's user interface. Three main windows are provided for defining your ENTii: **SCENE**, **LOGIC** and **LIBRARY**, each which is accessible by clicking the relevant button, as shown below:

1. **SCENE**, page 56, click to open the ENTii Scene Editor, which enables you to add, scale, position and rotate the assets to be included in the scene. It also enables you to define the properties of their appearance and some features of their behavior.

2. **LOGIC**, page 93, click to open the ENTii Logic Editor, which provides a visual interface for defining interactive, dynamic and complex ENTii behaviors.

3. **LIBRARY**, page 46, click to open the ENTii Library, which enables you to manage (view, upload, delete and so on) the assets (videos, images, audio files or 3D models) in the currently open ENTii.

4. **Workspace**: The center of the window is the general work area where you can visually design the scene, manage your Library assets or design your ENTii Logic.

5/6/7 **Tools/General Options/Lists and Properties**: The SCENE, LOGIC and LIBRARY windows each provide relevant tools and options in these areas.

8. **Menubar**, page 37, provides access to general ENTii Creator options, such as **Settings**, **Image Target** and so on.
Planning Your ENTiti

We recommend planning and preparing the following before you start:

- **AR/VR**: Decide whether you want to create an Augmented Reality ENTiti or a Virtual Reality ENTiti.
- **Storyboard**: Plan the design and experience that you want to create for your end users. For example, by writing a storyboard.
- **Assets**: Create and/or collect the assets (videos, images, audio files and/or 3D models) to be included in the ENTiti. A variety of AR/VR content can be downloaded and/or purchased through the Internet. For example, from reputable websites like turbosquid.com. Alternatively, you can use standard 3D modeling, animation or graphic tools to create assets.
- **Text**: Prepare the text to be included in the ENTiti.
- **Image target**: If you are creating an AR ENTiti, then you can decide which image target the end user must scan in order to activate the ENTiti. You may refer to page 41 for more information.
- **Logic and User Interaction**: Plan the logical behavior of the ENTiti, meaning its sequence of events, conditional behavior and user interactions.

Creating an ENTiti

ENTiti Creator enables you to create and manage multiple ENTiti, each which contains everything that is used by and will be published for that ENTiti.

► To create a new ENTiti in ENTiti Creator:

1. When ENTiti Creator is first launched, the Create or open project window is displayed by default. Alternatively, from the Project menu, you can select Open/Create to display the following window:
If you have used the ENTiTi Creator before, then this window may show a list of existing ENTiTis. Each ENTiTi Creator user can only see his/her own ENTiTis. Each previously created ENTiTi appears in a row and the following options are provided for each:

- **Open Button**: Click this button to open the ENTiTi in the Scene window, as described on page 56.
- **Type**: Indicates whether this ENTiTi is Augmented Reality (AR) or Virtual Reality (VR).
- **ENTiTi name**: Specifies the name by which this ENTiTi appears in the ENTiTi Creator and in the ENTiTi Viewer (users can search for it by this name).
- **Category**: Specifies the category under which this ENTiTi appears in the ENTiTi Viewer.
- **Token**: Specifies the developer token that enables you to view an unpublished (saved) ENTiTi on a mobile device. This is typically quite useful during the development process and during testing. You may refer to page 45 for more information.
- **Views**: Specifies how many times this ENTiTi was viewed in the ENTiTi Viewer.
- **Delete**: Enables you to delete this ENTiTi.

2 To create a new ENTiTi, click the **Create new project** button. The following displays:
3 In **Step 1**, select **Augmented reality** or **Virtual reality** according to the type of ENTiti that you want to create.

4 In **Step 2**, select to either:

- **Empty project**: To start from scratch and create an empty project. The Scene window opens and provides some initial instructions describing how to get started, as shown below:

- **A Template**: ENTiti Platform is provided with a variety of ready-made ENTiti templates into which you can simply drag-and-drop your own assets in order to customize it. For example, **Gallery**, **Newspaper** and **3D Object Viewer**, as shown above. The following is an example of the Scene window when a template is displayed. It comes pre-populated with assets and logic.
5 In **Step 3**, enter a name for your ENTtiti. This is the name by which this ENTtiti appears in the ENTtiti Creator and in the ENTtiti Viewer (users can search for it by this name).

6 Click the **Create** button. The ENTtiti authoring environment opens. You may refer to page 56 for a quick tour of the options in the Scene window.
ENTiTi Creator Menubar

The menubar provides the following options:

- **File Menu**, page 37.
- **User Menu**, provides the option to change your password or to logout.
- **Edit Menu**, provides standard copy, paste and delete options.
- **Settings Menu**, page 38.
- **Image Target Menu**, page 41. This option does not appear for a Virtual Reality ENTiTi.
- **Help Menu**, page 43.

### File Menu

- **Open/Create**: Enables you to open a new or different ENTiTi, as described on page 33. Each ENTiTi Creator user can only see their own ENTiTis.

- **Save**: Saves the ENTiTi.

  **NOTE**

  Saving an ENTiTi does not publish it.

- **Publish/Republish**: Enables you to publish or republish your ENTiTi so that it is available to anyone with an ENTiTi Viewer. After you publish an ENTiTi, you actually have two versions of it - the published version (that users can see in the ENTiTi Viewer) and the saved version which can be opened and edited by you in ENTiTi Creator.

  **NOTE**

  The word **Republish** appears instead of the word **Publish** when the currently saved version in ENTiTi Creator is not identical to the published version.

- **Unpublish**: Enables you to take down an uploaded ENTiTi so that it is no longer available in the ENTiTi Viewer.
• **Restore**: This option enables you to open a previously saved version of the current ENTiti. A list of the previously saved versions is displayed for your selection. Select one and then click the Open button to open it in the ENTiti Creator. You can then publish this ENTiti if you want.

• **Exit**: Exit the ENTiti Creator.

### Settings Menu

The ENTiti Creator is provided with default settings that enable you to start working immediately without the need to change any settings. The following describes how to modify **Project** (38) or **Editor** (page 40) settings, if needed.

#### Project Settings

This option enables you to modify various ENTiti settings.

Select **Settings ➔ Project** to display the following:

![Settings window](image)

**NOTE**

An existing ENTiti cannot be changed from Augmented Reality to Virtual Reality or vice versa.

Fill in the general details of this ENTiti and then click the **Update settings** button.

This information in this window influences how your ENTiti appears in the ENTiti Viewer app. The **Name** and **Short Description** are displayed in the ENTiti Viewer list. The **Location, Category** and **Keywords** properties help make your ENTiti easier to find when an end user searches for it in the ENTiti Viewer.
Screenshots

Screenshots are images that are displayed in the ENTITI Viewer list and in an ENTITI's description page. We suggest uploading multiple screenshots that are both attractive and descriptive. Screenshot image files should be 900×500 pixels (otherwise the image will either be stretched or show blank sides in the ENTITI Viewer list). You can use the free website www.picresize.com to resize your screenshot.

It is not mandatory to upload Screenshots. However, attractive Screenshots significantly increase the likelihood of viewers downloading your ENTITI. If you upload multiple Screenshots, then they are rotated in the ENTITI Viewer.

To define a Screenshot, click on one of the No Image boxes and select a file.

The Screenshot that you upload first will be the first one to appear in the ENTITI Viewer.

You need only define as many No Image boxes as you want. No empty boxes will be displayed in the ENTITI Viewer.

Ambient Color

This option specifies the color of the ambient light in a scene. Ambient light is the main light that illuminates a scene (similar to the sun). Typically, various shades of gray are used. Click this property to display a color picker:
**Editor Settings**

This option enables you to modify various ENTiti settings.

Select **Settings ➤ Editor** to display the following:

<table>
<thead>
<tr>
<th>Project</th>
<th>Editor</th>
<th>Hide auxiliary widgets</th>
<th>Windowed</th>
<th>Node Library Version</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Hide Auxiliary Widgets**: This option hides all the 2D sound objects from the Scene window (the authoring environment). This is useful because sound object icons take up window real estate while you are authoring in the ENTiti Creator. This option does not affect how the sound files play in the ENTiti Viewer.
- **Windowed**: By default, ENTiti Creator is displayed in a window (ON). Set this to OFF to display the ENTiti Creator as a full screen.
- **Node Library Version**: Displays the version of the Logic Library commands provided by Waking App.
Image Target Menu

An image target is an image representing a real world image at which an end user can point their mobile device camera running the ENTiTi Viewer, in order to activate an Augmented Reality (AR) ENTiTi. An AR ENTiTi can be activated by an end user scanning any one of multiple image targets that were assigned to the ENTiTi, as described on page 8.

We recommend adding a high quality image with many contrasts and details, in order to make end user scanning as easy as possible. Using a quality image will enable the end user to hold the mobile device further away from the image target and will enable ENTiTi Viewer to identify the image target and activate the relevant ENTiTi more quickly.

Many contrasting colors are better than gradients and similar grayscale shades. For example, dark blue on black will not show up as well as yellow on black.

Complex images with many details and sharp edges are better than monotonic, smooth circular images. For example, a picture of a house with furniture is better than a picture of the ocean.

The image size must be less than 2.25mb.

Select the *Image Target* option from the menubar to display the following window in which you can define the image target(s) of your AR ENTiTi:

![Image Target Menu](image)

This option is only relevant for an AR ENTiTi.

The left side of this window displays all the previously uploaded image targets (even for other ENTiTis that you authored).
The right side of this window displays the image target(s) that has been assigned to
this ENTiti. These are the only image targets that will activate the ENTiti when
scanned. Multiple image targets can be defined to trigger the same ENTiti.

The number of stars under each screenshot indicates the quality of the image, as
follows:

- **Zero or One Dots**: Not recommended
- **Two Dots**: Only use if you must
- **Three Dots**: OK
- **Four Dots**: Good
- **Five Dots**: Excellent

In the example above, the penguins on the top right left have excellent quality (Five
dots) and the orange flowers do not (Two dots).

► To assign an image target(s) to the currently open ENTiti:

1. Select the **Image Target** option from the menubar.

2. Click the **Upload** button to select an image file. The newly loaded image is then
displayed on the left. It has not yet been assigned to the ENTiti. For example, as
shown below:
Select the newly loaded image on the left and click the right arrow to move it to the right side of this window, as shown below:

Select this new image on the right and click the **PREVIEW** button to display it in the ENTITI Creator (and later in ENTITI Viewer).

To change the image target, double-click on it in the Scene window.

**Help Menu**

Select the **Help** menu option to display information about the ENTITI Creator application.
Saving and Publishing an ENTiti

We highly recommend that you save your ENTiti frequently.

► To save your ENTiti:

- From the Project menu, select Save or click the button.

**TIP** ENTiti Creator enables you to restore previous versions of your saved ENTitis using the Restore option in the Project menu, as described on page 38.

► To publish the ENTiti:

- From the Project menu, select Publish or Republish or click the button.
Viewing an ENTITi without Publishing

A Developer Token enables you to view an unpublished (saved) ENTITi on a mobile device. This is typically quite useful during the development process and during testing.

To enable the activation of an unpublished (saved) ENTITi:

1. When ENTITi Creator is first launched, the Create or open project window is displayed by default. Alternatively, from the Project menu, you can select Open/Create to display it, as shown below:

2. Each row of this window represents a different ENTITi. The Developer Token of each ENTITi is displayed in the Token column, as shown above.

3. On your mobile device in ENTITi Viewer, select Settings ➔ DEVELOPER TOKEN and then type in the developer token described above.
This chapter describes how to use the ENTiti Creator Library to upload assets into the ENTiti Platform. This chapter contains the following sections:

- **Introducing the ENTiti Library**, page 46
- **Asset Types**, page 47
- **Previewing Library Assets**, page 48
- **Uploading Assets to the Library**, page 48
- **Organizing Asset Folders**, page 50
- **Asset Format Guidelines**, page 51

### Introducing the ENTiti Library

Each ENTiti has its own Library into which you can upload the assets to be used in that ENTiti. The term **Assets** refers to the videos, images, audio files or 3D models that you can include in your ENTiti.

You can upload assets into the Library and then add them to the scene (as described on page 48) or you can upload assets directly into an ENTiti placeholder (as described on page 66).

> **TIP**

The quantity and size of assets that you add to a scene affect the size of the ENTiti that is published, whether the assets have been added to a scene or not.

Therefore, we recommend deleting assets from the ENTiti Library that you are not using.

If you delete an asset that is included in a published scene, a warning message is displayed. If you delete the asset anyway, the scene appears in ENTiti Creator during runtime as an empty placeholder.
To display the Library:

- Click the **LIBRARY** option at the top of the ENTtii Creator window.

**Asset Types**

Each type of asset appears in the center of the library window represented by a different icon, as follows:

- **Audio**
- **3D Model**
- **Image**
- **Video**

**NOTE**

Text is typed directly into the scene, as described on page 80. It does not appear in the Library.
Previewing Library Assets

Clicking on an asset in the library enables you to preview it in the top right corner of the Library window. Play buttons are provided, as shown below:

Audio  3D Model  Image  Video

Uploading Assets into the Library

Two methods are provided in ENTITI Creator for assigning an asset to a placeholder – one method requires that the asset be already pre-uploaded into the ENTITI Library. The procedure for uploading an asset into the Library is described below.

The other method enables you to both upload an asset file into the ENTITI Library and assign it to a placeholder in the scene in one step. This method is described on page 66.

To upload assets into the library:

1. Click the UPLOAD button to display a file selection window:
2 Select a file(s) and click **OK**. You can use the **CTRL** or **SHIFT** button to select multiple files.

As each asset is uploaded to the ENTiti Library cloud, a progress indicator is displayed.

Larger 3D models, videos and audio files take longer to upload depending on their size and your Internet bandwidth.

After a file is uploaded, 3D models, videos and audio files are automatically processed once. This may take up to 30 - 60 seconds (depending on its size) during which time a clock icon is displayed, as shown below:

3 Enter a **Name** for the file in the **FILE SETTINGS** area on the right of the window:

4 Additional file properties can be defined in the **FILE SETTINGS** area. Different properties appear for each type of file. More information about adding each type of asset is provided in the following sections:

- **Adding an Image**, page 68
- **Adding a Video**, page 75
- **Adding Sound**, page 76
- **Adding Text**, page 79
- **Adding a 3D Model**, page 81

**NOTE** You do not have to wait while the files are being uploaded and processed. You can start building your scene, as described on page 59.
Organizing Asset Folders

ENTiTi Creator provides the option to organize your assets into folders.

**NOTE**
Assets must be uploaded directly into a folder. They cannot be moved between folders.

► To create a folder:

1 In the Scene window, click the **CREATE Folder** button. The following displays:

   ![Create Folder dialog](image)

2 In the **Folder name** field, enter a name and click the **Create** button. The new folder appears in the Library as follows:

   ![Folder in Library](image)

3 To open the folder, double-click on it. An empty folder appears as follows:

   ![Empty folder](image)

4 Upload assets, as described on page 48.

**TIP**
Breadcrumbs appear at the top of the Library window to help you navigate among your folders.

50
**Asset Format Guidelines**

The following provides various guidelines regarding the format of the asset files that you can use in an ENTITi. Each asset file should not be larger than 40 MB.

- **Images**, page 51
- **Audio (Sound)**, page 52
- **Video**, page 52
- **3D Models**, page 55

**Images**

**File Format**

ENTITi Creator supports PNG and JPG image files.

**Image Transparency**

- JPG image files appear as full rectangles that are not transparent.
- PNG image files may have transparent backgrounds.

For example, the following shows both a JPG (which is a full rectangle) and a PNG (which has a transparent background).

As you can see, the dinosaur’s footprint is not a rectangular shape, so that it can be overlaid onto another graphic image without masking an entire rectangle.
Color Model

Image files must have an RGB (Red, Green, Blue) color model, not CMYK (Cyan, Magenta, Yellow, Black).

Various graphic tools enable you to see the color model of the file. For example, in Photoshop:

Resolution

Image files should be 72 DPI to get the best quality. This is a typical screen resolution. You can use files that have a larger resolution, but it makes the ENTii unnecessarily heavier.

Audio (Sound)

ENTii Creator supports MP3, Wav, Ogg, AIFF and AC3 audio files.

Video

ENTii Creator supports MP4, AVI, OGV and MOV (QuickTime) video files.
**Advanced Video Feature**

**Transparent Videos - Alpha Channels**

Alpha channel videos that contain transparency can be used as follows.

An alpha channel video is a standard video that contains an additional channel that masks the areas to be displayed.

The black area of the video is displayed 100% transparent, meaning that the graphic behind this video is shown. The white area represents the alpha channel, which indicates the part of the video that is opaque and is therefore displayed.

ENTIti Creator requires that the video to be displayed appears at the top and the alpha channel (that masks the area of transparency) appears underneath. This means that the height of the video is doubled. For example, if the original video size is 320×240 (W x H), then the video with an alpha channel will be 320×480.

Grayscale can be used to indicate partial transparency. For example, when 50% gray is used in the alpha channel, the video displays 50% transparently, so that the underlying graphic in the ENTIti can be partially seen.
When this type of video is added to a scene, in the Scene window, you must specify that it contains alpha channel transparency by setting the **Transparent** property of this video object to **ON**, as shown below:

If you forget to turn on the **Transparent** option in the scene, then this type of video will show both the top and the bottom parts.

You may refer to page 75 for more information about inserting videos in the scene.
3D Models

ENTiTi Creator supports FBX (Filmbox by Autodesk) 3D model files. This file format can be exported from many leading 3D authoring tools. Alternatively, you can use the Autodesk FBX converter to convert other 3D models formats to FBX. This converter can be downloaded from http://usa.autodesk.com/adsk/en/..

Apply the following guidelines when preparing a 3D model file for your ENTiTi:

- **File Size**: The maximum file size is 40M. However, less is optimal.
- **Textures**: Textures must be included inside the file and not as separate files. To do so, select the Embed Textures option when you export the FBX. Only use JPG and PNG image formats for textures. Texture size should optimally be below 2048x2048.
- **3D Mesh**: When exporting the 3D mesh, convert all objects to mesh. Multi/sub-objects are supported.
- **Animations**: FBX (Filmbox) by Autodesk.
- **Materials**: Only use standard materials. Diffuse maps can be used.
- **Transparency**: Use PNG textures with an alpha channel or transparent materials.
- **Visible Polygons**: For optimal performance, make sure that the scene you are preparing has less than 100K polygons visible at any given time.
- **Performance**: If needed, you can optimize ENTiTi Creator and ENTiTi Viewer performance to suit the mobile device on which it is running by defining no more than two sources of light and by reducing the amount of images, videos, 3D model animations and texture resolution. Generally, the less materials and polygons your scene has, the faster it runs.
This chapter describes how to use the ENTiti Creator Scene window to add, scale, position and rotate the assets in your ENTiti scene and to define their properties. This chapter contains the following sections:

- **Scene Window - Quick Tour**, page 57
- **Overview - Adding Assets to a Scene**, page 59
- **Opening a Scene**, page 60
- **Adding a Placeholder to a Scene**, page 63
- **Assigning an Asset to a Placeholder**, page 64
- **Adding an Image**, page 68
- **Adding a Video**, page 75
- **Adding Sound**, page 76
- **Adding Text**, page 79
- **Adding a 3D Model**, page 81
- **Adding Light**, page 84
- **Setting the Camera’s First View**, page 85
- **Adding Animation**, page 86
- **Advanced Scene Options**, page 90
Scene Window – Quick Tour

Click the **SCENE** button at the top of the ENTTi Creator window to display the scene window:

1. **SCENE**: Click this button to display the Scene window shown above.
2. **Stage**: This is the main stage and workspace in which you design your scene.
3. **Tools**: Each tool enables you to drag-and-drop a placeholder for a different type of asset into the scene.
4. **3D/2D TOOLS**: Both 3D and 2D assets can be dropped into a VR ENTTi. Select whether to display 3D or 2D tools in the Scene window.
5. **Show 2D**: This option is only relevant for AR ENTTis. It displays or hides the 2D objects in the ENTTi Creator Scene window. This does not affect how 2D objects appear to end users in the ENTTi Viewer.
6. **Scene View**: Displays the scene in the ENTTi Creator from a 3D perspective (**3D**) or from a perch directly above it (**Top**). This does not affect how 2D objects appear to end users in the ENTTi Viewer.
7. **Free Camera**: When **Free Camera** is **OFF**, right clicking and dragging the mouse moves the scene around you.
   When **Free Camera** is **ON**, right clicking and dragging the mouse controls the camera’s vantage point (point of view).

You may refer to the page 61 for more information.
8 **Scene Tools:** These tools enable you to create additional scenes and to navigate between them (page 90).

9 **Search:** Enables you to find objects in the Scene Object List by typing in their name.

10 **Scene Objects List:** Lists the objects that were added to the scene. Clicking on an object in the list selects it in the scene.

11 **Object Info:** Enables you to view and define various properties of the selected object, including its name. Each type of object may have different properties. Clicking on an object in the scene displays its properties in this area.

**Note:**

You can hover over anything in the user interface to display a tooltip describing it.
Overview - Adding Assets to a Scene

The process of adding an asset to a scene includes:

1. Opening a Scene: page 60, Opening a scene.

2. Adding a Placeholder to a Scene: page 63, Using one of the tools to add/drop a placeholder to the scene. A different tool is provided for dropping each type of asset into the scene.

3. Assigning an Asset to a Placeholder: page 64, Assigning an asset to the placeholder.

4. Defining the Object: Setting the name, position, scale and a variety of other properties of the object:
   - Image: 3D or 2D, page 68
   - Video: 3D or 2D, page 75
   - Sound: 3D or 2D, page 76
   - Text: 3D or 2D, page 79
   - Model: page 81
   - Light: page 84

The order of performing steps 2 – 4 is up to you. For example:

- You can use the tools to drop multiple placeholders into the scene, assign each of the assets and then define each of their properties.
- OR -
- You can perform all these tasks for each tool/placeholder/object individually.
Opening a Scene

To open a scene:

- When you create a new ENTiti (as described on page 33), a new scene automatically opens.
- Alternatively, you can add additional scenes to an existing ENTiti. You may refer to page 90 for a description of how to create additional scenes and how to open them.

AR vs VR

The authoring environment for creating AR and VR ENTiti is the same, except for the element that automatically appears in the center of the scene.

VR shows a camera and AR shows an empty image target, as shown below:

VR  AR

An AR ENTiti enables you to insert both 3D and 2D objects. A VR ENTiti only enables you to insert 3D objects, not 2D.

General instructions are displayed to help you get started.
Controlling the Scene in ENTiTi Creator

The following describes various options for controlling the scene in ENTiTi Creator. These control options enable you to see the scene from various vantage points in order to design it for the end user.

**NOTE**
The control options described below only affect how the scene is displayed in the ENTiTi Creator (the authoring environment). These options do not affect how the end user sees the scene when it plays in the ENTiTi Viewer.

**NOTE**
In the ENTiTi Viewer, the angle that the end user sees the scene is determined by:
- **AR ENTiTi**: How the end user holds the mobile device relative to the image target.
- **VR ENTiTi**: How the end user turns his/her head while wearing the goggles.

**NOTE**
To move a placeholder or object in a scene, simply click and drag it.

**Zooming In/Out**

To zoom in/out of the scene in ENTiTi Creator, right-click on the scene and use the mouse wheel.

**Free Camera - Panning the Scene**

The **Free Camera** option helps you see the scene from different vantage points while you are authoring the scene. Using this option enables you to design how the scene will appear to the end user when they hold their mobile device or goggles at different distances and angles. It does not affect how the scene appears to end users in the ENTiTi Viewer.

The **Free Camera** option appears in the bottom left of the scene window.

When **Free Camera** is **OFF**, right clicking on the scene and dragging the mouse moves the scene around you, meaning around the camera (for VR) or around the center of the image target (for AR).

When **Free Camera** is **ON**, right clicking on the scene and dragging the mouse moves the camera's vantage point (point of view) in the scene.
Turning the **Free Camera** option ON also enables you to control the camera’s point of view by right clicking the mouse and using the keyboard, as follows:

- **Getting Closer (W Key):** Press and hold the right mouse button and then press the W key to view the scene from a closer vantage point, meaning as if to move the camera closer.

  ![Closer (W Key)](image1)

  ![Further (S Key)](image2)

- **Getting Further (S Key):** Press and hold the right mouse button and then press the S key to view the scene from further away, meaning as if to move the camera further away.

- **Moving to the Right (D Key):** Press and hold the right mouse button and then press the D key to move the camera’s vantage point to the right.

  ![To the Right (D Key)](image3)

  ![To the Left (A Key)](image4)

- **Moving to the Left (A Key):** Press and hold the right mouse button and then press the A key to move the camera’s vantage point to the left.

**TIP**

To redisplay the camera in its default position, set **Free camera** to OFF.
Adding a Placeholder to a Scene

To add a placeholder to a scene:

1. The top left side of the Scene window provides a placeholder tool for each type of media that can be added to the scene.

   For an AR ENTiti, different tools are available according to whether you selected 3D or 2D in the 'TOOLS' option at the top left of the Scene window:

   ![Placeholder Tool Diagram]

   3D    2D
   3D IMAGE
   3D VIDEO
   3D SOUND
   3D MODEL
   3D LIGHT
   3D TEXT
   2D IMAGE
   2D VIDEO
   2D SOUND
   2D TEXT

2. Simply drag one of the tools onto the scene to add a placeholder of that type. For example, to add a 3D IMAGE.

   An empty placeholder (container) is displayed to which you can assign an asset (meaning a video, image, audio file, text or 3D model) and define its properties. A different type of placeholder appears according to the placeholder tool used and only the relevant type of asset can be added to that placeholder. For example, only a sound file can be added to a SOUND placeholder.

   You can now assign an asset to this placeholder as described on page 64.
Assigning an Asset to a Placeholder

The following describes how to select an empty placeholder (page 64) in a scene and then how to assign an asset to it.

There are two ways to assign an asset to a placeholder:

- **From the ENTiTi Creator Library**: Page 65, This method requires that the asset already be in the ENTiTi Library.
- **From a File**: Page 66, This method is a single-step procedure for both loading an asset file into the Library and assigning it to a placeholder.

More detailed descriptions are provided for describing how to assign asset type to a placeholder, starting from page 68.

Selecting a Placeholder/Object in a Scene

► Use one of the following options to select an object in a scene:

- After you drag-and-drop a tool into the scene, an empty placeholder appears in the scene. It is already selected and is ready for you to add an asset to it.
  - OR -
- Simply click on the placeholder in the scene.
  - OR -
- Use the **OBJECTS IN SCENE** list, which lists all the objects already added to the scene.
  - Click on an object name in the list to select it in the scene.
  - OR -
  - Type any part of the object’s name into the **Search** field to filter the list and then select the relevant object.
Assigning an Asset to a Placeholder from the ENTiti Library

The following procedure describes how to assign an asset to a placeholder after it has been uploaded to the ENTiti library.

▶ To assign an asset to a placeholder:

1. Make sure the asset has been added to the ENTiti Library (page 48).

2. Select the placeholder into which you want to load an asset (page 64). The properties of this placeholder are displayed on the right of the window.

3. Click the Select asset button to display a selection window showing all the assets in the Library of this ENTiti that have the same type as the selected placeholder. For example, all the Videos, all the Images or so on.

4. Select the desired asset file and click OK.

5. Use the object’s controls to position, rotate and scale it, as described starting on page 71.
6 Set the name, position, scale and a variety of other properties of the asset. A
detailed description of the special properties of each asset type is provided,
starting from page 68.

Assigning an Asset File to a Placeholder

The following describes how to assign an asset file to a placeholder directly from a
file on your computer, without using the ENTiti Library.

► To assign an asset file to a placeholder:

1 Select the placeholder into which you want to load an asset (page 64). The
properties of this placeholder are displayed on the right of the window.

2 Click on the button to display a file browser showing all the files that have the same
type as the selected placeholder.

3 Select an asset file and click the Open button. This file will be loaded into the
placeholder and displayed in the scene. It will also be loaded into the ENTiti
Library.
AR ENTITIs enable you to include both 3D and 2D images, video and text. 3D objects move with the scene that you create. The perspective, size and angle that you see the 3D object changes along with the rest of the scene as you move the mobile device or goggles. 2D objects remain static in the same position. 2D objects appear, as if glued to the mobile device lens or to the goggles. In the following example, the giraffe is 3D and the buttons and icons are 2D.
Adding an Image

► To add an image:

1. Drag-and-drop an Image tool into the scene.

The scene visually reflects the perspective and distance that the image is dropped from the camera. For example, as shown below:

**NOTE**

2D images can be added to AR ENTITis using the tool. 2D images appear static as if they are stuck to the camera lens and can be used for things like a scoreboard or logo.
2 Click on the placeholder to display its controls and properties:

3 Use one of the two methods provided for assigning an asset to a placeholder as described in the Assigning an Asset to a Placeholder from the ENTiti Library section (on page 65) and Assigning an Asset File to a Placeholder section (on page 66).

4 In the Name property, enter a unique name for this object in the scene. The name of the asset is then displayed at the bottom of the OBJECTINFO area, as shown below:

To quickly add a placeholder, assign it an asset and upload a file into the Library, click the button.

If you have a scene with many objects, then assigning them recognizable names makes them easier to find in the OBJECTS IN SCENE list.
5 Define whether the image is clickable by toggling the hand icon in the ITEMS IN SCENE list to white (clickable) or gray (not clickable).

You may refer to page 71 for more information.

6 Adjust the **position**, **rotation** and **scale** of the object using its controls and properties. The controls and properties both reflect the state of the object in the scene – when you change one the other changes accordingly.

- Positioning an Image, page 71
- Rotating an Image, page 73
- Scaling an Image, page 74

7 2D objects appear in a static position on the mobile device screen according to the definition in the **Anchor** property. The following is displayed when you click the **Anchor** property:

Select the position of this 2D object on the mobile device screen and click the **Confirm** button. For example, **Top Right** or **Bottom Left**.

Selecting the **None** option will position the 2D object in the middle of the ENTiTli Viewer screen.
In the Anchor’s X and Y properties define the offset of the center of the object from the position selected above. The default is X = 0 and Y = 0, meaning no offset.

**TIP**

If you drag an object in the scene, it snaps to the position defined by the Anchor.

The word snap means that the object jumps to the anchored position when it is dragged close enough to that position in the ENTiTı Creator scene.

**TIP**

To define two or more objects with a static relative position to each other (meaning with a consistent distance between each other), assign them both the same Anchor (for example Bottom, Left) and then assign each a different (X, Y) Anchor offset.

8 Save the ENTiTı by clicking the button.

**Making an Object Clickable**

A hand icon appears to the right of each object in the OBJECTS SCENE list. It appears white when the object is clickable by the end user in the ENTiTı Viewer and gray when it is not.

Clicking on the hand icon toggles it clickable (white hand) or not clickable (gray hand).

This option is useful when there are multiple layers of objects in the scene, such as a room that has walls and things in the room, like furniture. To specify that an object in the room is clickable, such as a gift on a table, make sure the hand is displayed white. To specify that an object in the room is not clickable, such as the table, the walls and the floor, make sure the hand is displayed gray.

Various Logic commands require that the object be clickable in order to apply. You may refer to page 93 for more information about the Logic commands.
Positioning an Image

ENTiTli Creator enables you to move an object in the scene in any direction.

► To position a 3D image by dragging:

Click to select the Position tool or type W. Directional arrows are displayed on the image, as shown below:

3D Image

Simply click and drag the relevant arrow to move the object in that direction. For example, the green arrow moves the object upwards.

► To position a 2D image by dragging:

Simply click on the object and drag it to the new position.

2D Image

► To move an object by typing in coordinates:

You can type in the exact position of a 3D or a 2D object into the X, Y, Z Position properties, as shown below:

<table>
<thead>
<tr>
<th>position</th>
<th>X</th>
<th>Y</th>
<th>Z</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-3.324</td>
<td>-1.982</td>
<td>3.4378</td>
</tr>
</tbody>
</table>
Rotating an Image

ENTiti Creator enables you to rotate an object in the scene in any direction.

► To rotate a 3D image by dragging:

Click ☰ to select the Rotation tool or type E. Directional circles are displayed on the image, as shown below:

![3D Image](image1.png)

3D Image

Simply click and drag one of the circles to rotate the object in that direction.

► To rotate a 2D image by dragging:

Click on the green handle at the top of the 2D image and drag it to rotate the image, as shown below:

![2D Image](image2.png)

2D Image

► To rotate an object by typing in coordinates:

You can type in the exact rotation of a 3D or a 2D object into the X, Y, Z Rotation properties.
Scaling an Image

ENTiTi Creator enables you to resize the object in the scene.

► To scale a 3D image by dragging:

Click \(\text{X} \) to select the **Scale** tool or type \(R\). Handle bars are displayed on the image, as shown below:

![3D Image](image)

Simply click and drag one of the image’s handle bars to stretch or shrink the image in that direction. Clicking and dragging the white cube resizes all dimensions simultaneously.

► To scale a 2D image by dragging:

Simply click and drag one of the image’s handles to stretch or shrink the image.

![2D Image](image)

► To scale an object by typing in coordinates:

You can type in the exact size of a 3D or a 2D object into the X, Y, Z **Scale** properties, as shown below:

<table>
<thead>
<tr>
<th>scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>X 1</td>
</tr>
<tr>
<td>Y 1</td>
</tr>
<tr>
<td>Z 1</td>
</tr>
</tbody>
</table>

**Tip**

You can use `CTRL + Z` keys at any time to undo your last operation. Multiple undo options are provided.
Adding a Video

To add a video:

1. Drag-and-drop a Video tool into the scene.
2. Click on the placeholder to display its controls and properties.

   Video Controls

   Video Properties

3. Use one of the two methods provided for assigning an asset to a placeholder as described in the Assigning an Asset to a Placeholder from the ENTITi Library section (on page 65) and Assigning an Asset File to a Placeholder section (on page 66).

   NOTE

   2D videos can be added to AR ENTITiS using the 2D video tool. 2D images appear static as if they are stuck to the camera lens.
The first frame of the video is displayed:

4 Define the **Name**, **Visible** (page 70), **position** (page 71), **rotation** (page 73) and **scale** properties (page 74).

5 Click the **Anchor** property to define the relative position of this 2D video on the mobile device screen.

6 Set the **Transparent** property to **ON** or **OFF**. **ON** specifies that this video contains an alpha channel which defines its transparent areas, as described on page 53.

7 Set the **Auto Play** property to **ON** or **OFF**. **ON** specifies that this video will automatically start playing when the ENTiti is activated. **OFF** specifies that the video will only start playing when activated by the ENTiti's Logic, as described on page 93.

8 Save the ENTiti by clicking the **Save** button.

**Adding Sound**

Add a sound object to the scene for each sound to be played in the ENTiti.

2D sound objects are heard regardless of the end user’s position in the ENTiti.

The position of each 3D sound object determines the position from where the end user can hear the sound. The position of the end user is determined by:

- **AR ENTiti**: Where the end user is pointing the center of the mobile device’s camera.
- **VR ENTiti**: Where the end user is looking with the goggles.

ENTiti Creator enables you to define the area around a 3D sound object where the end user will hear the sound the loudest. As the end user gets further away from this area, the sound becomes fainter. In a VR ENTiti, if an end user is positioned equidistance between two sounds, then the sound at which the camera is pointing is heard.
You may use the **Hide Auxiliary Widgets** option described on page 40 to hide all 2D sound objects from the Scene window (the authoring environment). This is useful because sound object icons take up window real estate while you are authoring in the ENTiTi Creator. This option does not affect how the sound files play in the ENTiTi Viewer.

You can then use Logic to determine when the sound is played, as described on page 93.

**To add sound:**

1. Drag-and-drop a Sound tool into the scene.
2. Click on the placeholder to display its controls and properties.
3. Use one of the two methods provided for assigning an asset to a placeholder as described in the Assigning an Asset to a Placeholder from the ENTiTi Library section (on page 65) and Assigning an Asset File to a Placeholder section (on page 66).
4. Fill in the **Name** property.
5. Define the **position** of the sound, as described on above and on page 72.
6 Set the Volume between 0 and 1.

7 Set the Pitch property to define the highness (+2) or lowness of the tone (-2).

8 Set the Range property to define the range of the distance from which the sound can be heard in the scene. A transparent whitish circle is displayed to indicate the area in the scene where the sound is heard the loudest. The further away from this whitish circle, the more faint the sound.

The larger the Range value, the further away the sound can be heard in the scene.

9 Set the Auto Play property to ON or OFF.

10 Save the ENTiti by clicking the button.
Adding Text

The following describes how to add a line of text to your scene.

You can define variety of text related behaviors in your ENTtI using the Logic option (page 93).

In Scene (3D) and On Screen (2D) Text

AR ENTtIs enable you to include both In Scene (3D) and On Screen (2D) text objects.

In Scene (3D) text moves with the scene that you create. The perspective, size and angle that you see the 3D text changes along with the rest of the scene as you move the mobile device or goggles.

On Screen (2D) text remains static in the same position. On Screen text appears as if glued to the mobile device lens or to the goggles. On Screen text is particularly useful for displaying instructions, buttons or menu options. For example, as shown below:
Adding Text - How To

To add text:

1. Drag-and-drop a Text tool 📝 or 📝 into the scene.
2. Click on the placeholder to display its controls and properties:

3. Use one of the two methods provided for assigning an asset to a placeholder as described in the Assigning an Asset to a Placeholder from the ENTii Library section (on page 65) and Assigning an Asset File to a Placeholder section (on page 66).
4. Define the Name, Visible (page 70), position (page 71) and rotation (page 73).
5. Click the Anchor property to define the relative position of this On Screen (2D) text on the mobile device screen.
6. Set the Font Size property to specify the size of the font between 1 and 100.
7. In the Text property, enter the text to be displayed.
8. Save the ENTii by clicking the button.
Adding a 3D Model

To add a 3D model:

1. Drag-and-drop a 3D Model tool into the scene.

2. Click on the placeholder to display its controls and properties.

3. Use one of the two methods provided for assigning an asset to a placeholder as described in the Assigning an Asset to a Placeholder from the ENTtI Library section (on page 65) and Assigning an Asset File to a Placeholder section (on page 66).

4. Define the **Name**, **Visible** (page 70), **position** (page 71), **rotation** (page 73) and **scale** properties (page 74).

5. In the **Offset** property, specify the coordinates (X, Y, Z) around which the 3D model rotates. This value also represents the point of the 3D model that is placed in the position defined by the **position** property (page 72). By default, this is the center of the 3D model.

There are some cases where you might want this offset to be the bottom of the 3D model. For example, when you want to position an object on top of another object, such as a car driving on a road. The road might be positioned at coordinates 0,0,0. This can be specified as the bottom of the car, so that its wheels will drive on the road.
Another example is a boat floating in water. In this case you might set the offset to be slightly above the bottom of the boat, so that the boat looks like it is in the water.

6 Click the **Select Materials** button to adjust the materials from which the 3D model is comprised. A list of the materials used in the 3D model is displayed:

Select one of the materials in the top right of this window to display the material's properties, as shown below:

- **Roughness**: Represents the difference between the maximum peaks and maximum valleys of a surface in the quantity of such differences.
- **Color**: Specifies the color of the ambient light of this 3D object. Ambient light represents the light already present in a scene before additional lighting is added and usually refers to natural light, such as from the sun.
- **Main Texture**: Click this button and select one of the options displayed below:

![Select Material](image)

The **Depth Mask** option is provided primarily for AR ENTiti. Augmented reality deals with the interaction of digital objects with real world objects. The Depth Mask material is used to represent a real world physical thing that hides 3D model things.

The depth mask enables you to position a mask on a real-world shape so that when a digital object goes behind that real-world shape, then the digital object is hidden.

For example, when a digital spaceship flies behind a real-world doll. In this case, a mask must be created representing the real world though so that when the spaceship flies behind the mask representing the doll, the spaceship is hidden.

7 Save the ENTiti by clicking the **Save** button.
**Adding Light**

The **Light** tool enables you to place directional light into a scene, such as the sun. Multiple Lights can be placed in a scene, each with a different direction, color and intensity. However, we do not recommend placing more than two Lights in a scene because as it may slow down the user’s experience.

► **To add light:**

1. Drag-and-drop a **Light** tool into the scene. A Light icon is added to the scene to indicate the direction of the light.

2. Define the **Name**, **Visible** (page 70), **position** (page 71) and **rotation** (page 73) **scale** properties. The direction of the rays coming out of the Light icon represent the direction of the light. Therefore, you should rotate the rays of this Light icon accordingly. For example, the picture above shows the sun shining on the left side of the cube; the picture below shows the light shining away from the cube:
3 Click the Color property to select the color of the light.

4 In the Intensity property, enter a value between 0 and 1 (for example, 0.3) to specify how strong the light is.

5 Save the ENTiti by clicking the button.

Setting the Camera’s First View

A camera appears automatically in a VR ENTiti (there is no camera in an AR ENTiti). The following describes how to define the first view that the end user sees when they first enter the VR ENTiti.

► To set the first view of the camera:

1 Define the Name, Visible (page 70), position (page 71) and rotation (page 73).

   ▪ The position of the camera determines where the end user is standing inside the new virtual world. The position of the camera remains static in the scene, meaning that the end user remains in a fixed position in the scene and can look around from that position (rotation, as described below).

   ▪ The rotation of the camera determines where the end user is looking in the scene, as if to specify the direction in which the user’s head is turned.
2 The Aspect Ratio property is set to 1 to 1 by default, which is generally optimal. For example, if the Aspect Ratio is set to W = 3 and H = 1, then the image seen by the camera will be three times wider than its height, which will be shown in the Camera Preview area.

3 The Gaze Crosshair property enables you to define the image to be used as the crosshair that represents where the goggles are pointing, meaning where the end user is looking. Click the Select asset button to upload a transparent JPG or PNG file.

4 Save the ENTiti by clicking the button.

Adding Animation

A 3D model asset can contain animation. Animation is comprised of a sequence of frames. Animation can be previewed in the top right of the Library window, which provides play and stop options, as shown below:

![Library Window with Animation Preview]

If the 3D model contains a single animation sequence to be played in the ENTiti in its entirety, then it can be treated in the same way as a standard 3D model, as described in page 81.

Creating Animation Clips

In addition to enabling you to add an entire animation sequence, the ENTiti Creator Library enables you to clip the animation sequence (meaning to use specific pieces of it) and then drop those clips into the scene.

Creating animation clips enables you to run specific parts of an animation, such as a dog walking, barking or wagging its tail. For example, you might create a clip of a dinosaur taking two steps. This animation clip can be played in a loop which gives the effect of the dinosaur walking.

In order for you to know which frames of an animation to use, the person who created the animation must give you a list of the frame numbers in the animation that show specific behaviors.
This information can be provided in a variety of ways, such as in an email, Notepad or so on. The following is an example of this kind of information. For example, it shows that the T Rex roars from frame 1420 to 1460.

To create the animation clips:

1. [Optional] Open the ENTiti Creator library and select the animation file. Click the Play button to preview the animation. For example, trex.FBX.

2. In the Name property, enter a descriptive name for the animation clip.

3. For each clip of the animation that you would like to create, click the + button to add another clip row.

The following shows an added row:

NOTE: You can click the - button to delete a row.
4 In the Name property of this new row, enter a descriptive name for the animation clip. This is an internal name that will help you recognize this animation clip.

**TIP** We recommend adding short names which will later be easy to recognize when you drop the clips into your scene.

5 According to the frame numbers that you received from the animation creator, in the Start and End properties, specify the numbers of the first and last frames to be included in the clip.

6 Set the Loop property to On to define that the animation will play repeatedly. For example, a Walking animation should probably play in a loop while a Roar animation need only play once (if needed, you can always activate it again).

**NOTE** The Logic commands described on page 93 can only check the ending of the animation clip, if its Loop property is not On.

7 Repeat steps 3 - 6 for each animation clip to be created.

8 **Important!** Click the Process/Reprocess button to process the animation. A message is displayed while the information is processing. This may take 10 to 30 seconds.

9 After Process/Reprocess has been completed, selecting the 3D model file that contains the animation again (in the center of the Library window).
The following window displays listing the animation clips that you defined, as described above):

![Choose animation window](image)

10 For each animation clip in this window, perform the following:

- Select the animation clip.
- Click the **Confirm** button.
- Watch the animation preview in the top right of the Library window.
- Verify that the animation clip shows the frames that you are expecting. If not, then modify them.

A variety of drag-and-drop logic commands are provided for playing animation, as described on page 93.
Advanced Scene Options

Adding Additional Scenes

A single scene may be enough for most ENTiTiis. If needed, you can add additional scenes to your ENTiTi. For example, you may create a different scene for each page of a story or each level of a game.

Each new ENTiTi opens by default with a single scene. The top right of the ENTiTi Creator window provides the option to add, rename or delete a scene.

Logic commands enable you to define when a scene changes in the runtime ENTiTi, as described on page 93.

► To rename the current scene:

  • Click and enter a new name.

► To add a new scene:

  1  Click

  The following displays:

  2  Enter a name for the scene and click OK. A new scene is then displayed.
To display a specific scene:

1. Click . The following displays:

![Scene selection screen]

2. Select a scene and click the Confirm button.

**Object Physics**

The physics options allow for collisions/overlaps and gravity simulation:

1. **Gravity** - Simulates earth gravity on the selected object. Use the feature for objects that should be affected by gravity:
   - In the Object Info box, select the Physics section.
   - Toggle Gravity to On.
   - When the experience is launched in the viewer, the object falls.

2. **Fixed Object** - Sets the object as static. It will not be affected by collisions and gravity. Use this feature for objects that should not move, like floor or walls:
   - In the Object Info box, select the Physics section.
   - Toggle Fixed Object to On.
   - When the experience is launched in the viewer, the object remains in place.
3  **Go Through** - Sets the selected object to go through (overlap) other objects:

- In the **Object Info** box, select the **Physics** section.
- Toggle **Go Through** to **On**.
- When the experience is launched in the viewer, the object overlaps other objects instead of colliding with them.
This chapter describes how to add advanced app-like interactivity, even to a level of games by just dragging and dropping. This chapter contains the following sections:

- Introducing ENTÍTI Logic, page 93
- ENTÍTI Logic Window - Quick Tour, page 94
- Defining ENTÍTI Logic, page 98

### Introducing ENTÍTI Logic

ENTÍTI Creator’s Logic feature enables you to create interactive, dynamic and complex ENTÍTI behaviors. ENTÍTI Creator provides dozens of Logic commands that enable you to design unlimited ENTÍTI behaviors, interactivity and presentation options.

ENTÍTI Creator provides a very easy drag and drop logic design interface that enables anyone to create interactivity without any previous knowledge, code or programming skills. In addition, more advanced options are easily applied.

ENTÍTI Logic enables you to control the playing, positioning, timing, movement and rotation of any object anytime according to any conditions. A rich variety of dynamic ENTÍTI runtime behaviors can be designed including interactive videos, randomly selected animations, controlling data and even games.

The ENTÍTI Logic window provides a self-explanatory drag-and-drop visual interface for defining advanced logic realities called a Flow Map. Each logical node in the Flow Map represents a command. The flow through the commands determines the behavior of the ENTÍTI. The sequence of this flow is represented as directional arrows between nodes and is dependent upon the optional conditions that you define.
The process of defining an ENTiti’s Logic consists of:

- Defining an event that triggers the start of the ENTiti’s behavior, defining the sequence of events that occur in the ENTiti.
- Defining the user interaction options presented to the end user in the ENTiti Viewer.
- Defining the conditions that determine the flow through the commands in the Flow Map.

**ENTiti Logic Window – Quick Tour**

▲ To display the Logic window:

Click the **LOGIC** option to display the Logic window, as shown below:

1. **LOGIC Button**, click this button to display the LOGIC window, shown above.
2. **LOGIC Tools**, enable you to **COPY**, **PASTE** and **DELETE** commands in the Flow Map and to **CENTER** the display of the Flow Map in the Logic window.
3. **Command Search**, enables you to **search** for commands in the Commands List according to their name.
4 Command Groups List, each group represents a type of command, such as Input commands, Media commands, Math commands and so on. Each group can be expanded in the pane on the right to display all the commands of this type. A Command Group cannot be dragged and dropped onto the Flow Map (only a command can). The following is the Commands List completely collapsed so that only the groups are shown:
To expand/collapse a Command Group in order to see the commands that it contains, simply click on it. The following shows the **General** Command Group and the **Input** Commands Group expanded so that the commands contained in each are displayed:

5 **Commands**, Logic commands are listed in the pane on the right of the window. Each command can be dragged and dropped onto the Flow Map in order to design ENTti Logic (flow, interactivity and behavior). A detailed description of each command will be provided in the near future.

6 **Flow Map**, provides a visual representation of the Logic that you design for the ENTti. The following describes some of the options for controlling the design in the Flow Map:

- To select a command (node) in the Flow Map, click on it.
- To move a command, click and drag it.
- To pan (move) the displayed Flow Map, right-click on it and drag the mouse.
- To zoom in/out, click on the Flow Map and turn the mouse wheel.
- To center the middle of the Flow Map in the Logic window, click on the mouse wheel.
To select multiple commands, drag and draw a selection rectangle.

To delete a command from the Flow Map, select it and click **DELETE** or more press the **Delete** key.

7 **Comments**, page 114, set this to **ON/OFF** to specify that comments are shown/hide on the Flow Map.

8 **Values**, set this to **ON** to specify that the values of commands are displayed in the Flow Map instead of their data type.

**Tooltips**

You can click on various parts of a command in the Flow Map to display a tooltip describing it, such as shown below:

- Each black handle represents either an input parameter or an output parameter of the command.
- Hovering over a commands handle indicates its data type and whether it is an input parameter or an output parameter.
Defining ENTITi Logic

The ENTITi Creator enables you to define the behavior of an ENTITi by designing a Flow Map in the Logic window.

The following is a general workflow for defining the Logic of an ENTITi:

- Adding Commands to the Flow Map, page 99
- Defining Command Triggers - Events, page 102
- Defining Logic Flow, page 104
- Defining Command Parameters, page 109
- Adding Variables, page 112
- Adding Comments, page 114
- Adding Scene Objects, page 115
- [Advanced Feature] Adding Custom Actions, page 115
• Add Timing Commands, page 118
• Defining Conditions, page 119
• Defining Random Behavior, page 120

Adding Commands to the Flow Map

Logic commands are listed in the pane on the right of the window. Each command can be dragged onto the Flow Map in order to define ENTIti Logic. A detailed description of each command will be provided in the near future.

Each type of command appears with a different colored indicator in the Command Groups List, as shown below:
To add a command to the Flow Map:

1. Expand the relevant Command Group in the Commands List pane on the right of the LOGIC window to display the relevant command, as described in page 95.

2. Drag a command from the Command List onto the Flow Map. The command appears as a circular node, which may have one or more black handles, each of which represents an input or an output parameter of that command. For example, as shown below:

You can add as many Logic commands as needed.
Each type of command appears with a different color after it is dropped on to the Flow Map, as follows:

- **Red**: Events
- **Light Blue**: Actions
- **Green**: Variables
- **Dark Blue**: Objects
- **Purple**: Custom Actions

**TIP**

Any action that you perform can be undone by pressing the **CTRL+Z** keys or redone by pressing the **CTRL+Y** keys.
Defining Command Triggers - Events

The first command in a Flow Map must always be an Event command. An Event command triggers the start of the ENTiti's flow.

For example, the On Start command triggers the ENTiti's flow immediately after the ENTiti is launched and the On Touch Started command triggers the ENTiti's flow immediately after the end user touches the relevant object in the ENTiti Viewer.

Event commands appear with a red dot in the Command Groups List, as shown below:

A red exclamation mark next to a command indicates that there are some constraints regarding the usage of this command. Click the to read a description of the constraints.
One or more Event commands can be added to an ENTtii. The ENTtii is then activated when any one of these events occurs. For example, if an ENTtii has both an **On Touch Started** event and an **On Button** event then, the ENTtii starts running when either the object defined for the **On Touch** event is touched or the button defined for the **On Button** event is tapped.

**To define Event commands:**

1. Drag-and-drop an Event command into the Flow Map (Event commands have a red dot in the Commands List).

An Event command has a [connection out](#) at the bottom, which is called a Connection Out (or exit). In order to define the logic flow this [connection out](#) can be connected to the [connection in](#) (called a Connection In) of another command that will be triggered after the Event command is activated.

**NOTE** An Event command does not have a [connection in](#) (Connection In) because it is the first thing to happen in an Event’s lifecycle.
**Defining Logic Flow**

The flow of an ENTiti’s behavior starts from the Event command that triggers the activation of the ENTiti behavior. The directional lines that you draw from the [Event] to the [Next Logic command] determine the flow of the activation of commands.

Action commands have both a Connection Out [Connection Out] and a Connection In [Connection In], as shown below:

► To define the Logic flow:

1. Click and hold the [Command] of a command (such as the Event command) and drag and draw a directional flow arrow (line) between the Event command and the next Logic command in the Flow Map. For example, between the **On Touch Started** Event command and the **Play Animation** Action command, as shown below:
A valid connection displays a directional line in blue (with an arrow pointing in a specific direction) as you are drawing it. After it is completed, it turns whitish, as shown below:

**General Rules for Connecting Flow Map Commands**

If you violate one of the following rules, the directional arrow between two commands appears pink to indicate that it is invalid, as shown below:
• The of a command can only be connected to a single of another command.

• Multiple (each of a different command) can be connected to the same of another command. For example, the following shows how multiple Event commands can trigger an animation to play.

• Commands cannot be dropped into each other and can only be attached by dragging and drawing the directional arrows between them.
To activate more than one Logic command at the same time, connect the Logic commands in a chain. For example, the following shows how an Event command triggers the activation of both an Animation and an Audio at the same time:

NOTE
To define that the next command in the flow is only activated after the current one completes, use one of the Wait type command, as described on page 118.
After you have dropped multiple commands into your Flow Map, you can see the sequence of events that will occur when an Event command is triggered by double-clicking on that Event command in the Flow map.

For example, double-clicking on the **On Start** command, displays a small ball that travels along the sequence of commands that will be activated, as shown below:

You can click the **Stop** button in the Flow Map to stop the display of this flow in the Logic window.

You can organize the Flow Map in the Logic window by dragging the commands as you wish order to achieve a more clear and aesthetic appearance. For example, in order to move some commands close to each other or to uncross flow lines.

You can also drag the parameter handles of each command to another side of the command. For example, as shown below:
Defining Command Parameters

After an Action command is dragged onto the Flow Map, it may automatically appear with one or more black handles representing input or output parameters.

For example, the following shows the **Play Animation** command that automatically appears with two parameters: **Model** and **Animation**.

![Play Animation](image1)

For example, the following shows the **On Touch Started** command that automatically appears with two parameters: **Touched** and **Position**.

![On Touch Started](image2)

A detailed description of each command will be provided in the near future.

To display a description of each parameter:

Simply hover over it in the Flow Map. The tooltip that is displayed describes the purpose of the parameter and whether it is an input parameter (**Object In**) or an output parameter (**Object Out**).

For example, the following shows the tooltip that is displayed when you hover over the **Audio** parameter of the **Play Audio** object. This parameter enables you to define which audio file is played.
To set/modify a parameter (handle) value:

Either:

- Double-click on a handle and then select or type in a value, as shown below:

```
Selecting an Object from the ENTíTi Library
```

- OR -

- Drag and draw a connection from a Variable command to the handle, as shown below:

```
Entering Text
```

A connection can only be drawn to/from a Variable command of the same data type, meaning text to text, object to object and so on.

An input parameter handle only allows a directional arrow to be drawn to/from another command handle. An output parameter handle only allows a directional arrow to be drawn from/to another command handle. Otherwise, the directional arrow is displayed paint to indicate that it is invalid.
For example, the following shows the **Play Animations** object:

It has two handles **Model** and **Animation**.

After the handles have been defined, it will play the **happy_idle** animation in the **my figure** 3D model when the ENTiti is launched (On Start Event).
Adding Variables

Variable commands are containers for data in the Flow Map. They appear in green in the Variable command group in the Command List pane. For example, the Flag, Number, and Text Variable commands shown below:

It is not mandatory to connect a Variable command to any other command. They can simply be dropped into the Flow Map.

Using Variables commands enables you to store data to be used by other commands in the Flow Map, such as to start with an initial value and to modify that value.

A different Variable command is provided for each data type. For example, the Number Variable command can be used to store the score of a game. Its initial value is defined by you when you design the ENTiti in the Logic window (for example, zero); and you can design that is modified by a Math command that is triggered every time the end user taps a specific object in the ENTiti.
You can also see whether a handle represents an input parameter or an output parameter by dragging and drawing a directional line from it. The direction of the arrow indicates whether it is input or output.

► **To assign a value to a command's handle (parameter) from a Variable command:**

1. Add a Variable command to the Flow Map, as described on page 112. Make sure that it has the same data type as the parameter (handle) required by the Action command. For example, if the parameter requires a number as input, then make sure you have added a number Variable command to the Flow Map.

2. Drag and draw a directional line from the Variable Command to the number parameter handle of the command.

   The Flow Map does not allow you to draw a directional line from the wrong data type into a command's parameter handle.

   **TIP**

   You can click the space bar to toggle the display of the parameter values on the handles of all the commands in the Flow Map. Alternatively, you can set the Values setting on the bottom left of the Logic window to ON to display parameter values instead of parameter types.

For example, the **Play Animation** Action command has two input parameters: **Model** (which specifies the 3D model in the ENTiti Library) and **Animation** (which specifies the name (text) of an Animation contained in the 3D model).
Adding Comments

The Comments command enables you to label things in the Flow Map that are only shown in the authoring environment (not in the ENTITI Viewer). Comments appear with a yellow indicator in the Commands List pane, as shown below:

After you drag and drop a Bookmark (Comment) command into the Flow Map, it appears with default text. For example, as shown below:

► To enter a comment:

Click on it to display an edit box, as shown below:

Modify the text as needed.

To make the text bold, set the Make Bold option to ON.
Comments can be moved anywhere on the Flow Map by dragging them. They can be used to describe a specific command or a group of commands in the Flow Map.

Alternatively, we recommend anchoring them to specific commands in the Flow Map.

Each **Bookmark** that is added to the Flow Map then appears in the Commands List under the **Flow** group, as shown below:

![Flow and Bookmarks](image)

▶ **To jump directly to a bookmark:**

Click on it in the Comments List. The bookmark is then displayed as the center of the flow map and is selected.

**Adding Scene Objects**

A Scene Object is one of the items that you added to the scene. These are all listed in the Scene List. Scene Objects are displayed in dark blue.

The list of Scene Objects that appears in the Commands List is the same as that which appears in the Scene Item List, as shown below:

![Scene Object Commands and Scene Items List](image)

**Scene Object Commands**  **Scene Items List**

An object appears with a red X when it is empty, as shown below:

![Empty Object](image)
Adding Custom Actions

Custom Actions are an advanced feature that enable you to organize the commands in your Flow Map. Custom Actions group together the commands in the Flow Map as a kind of subroutine. This means that you can assign a name to multiple commands in the Flow Map and then easily reuse them with different input parameters. For example, if a Custom Action has a parameter handle that represents an object name, then the Custom Action can be activated repeatedly, each time with a different object (object name parameter value).

The Commands List initially shows the Custom Group containing a single command named Custom.

To add a custom action to the Flow Map:

Drag the Custom command from the Commands List onto the Flow Map. The newly added Custom Action appears purple:

This newly added Custom Action is then added to the Commands List in the Custom group, as shown below:

To change the name of the Custom Action, simply type in the new name in the right pane. This changes the name in the Commands List and in the Flow Map.

You can then double-click on the purple Custom Action command in the Flow Map to open an empty area in the Flow Map. All the commands that you add to this new empty area belong to the Custom Action.
To add a variable to a Custom Action:

1. Drag one of the Variable commands from the Commands List into the Flow Map of the Custom Action.
2. Double-click on the Variable node to display the following.

```
Text
animation name
```

3. Set the **Expose Variable** option to ON. This automatically displays this Custom Action in the main Flow Map with an additional parameter handle representing this variable. For example, the picture above shows the **Animation Name** Custom Action command with a **Text** handle parameter representing the Variable.

To activate a custom action:

Simply draw a directional arrow to it in the Flow Map.

**TIP**

If all you want to do is organize your Flow Map, then instead of using Custom Actions, you can simply physically group nodes in separate areas of the Flow Map. For example, as shown below:

**NOTE**

A Custom Action can also contain an Event command that triggers it.
Add Timing Commands

In the General Command Group, you can use the Repeat Every Frame or the Repeat Every X Seconds commands to specify how often a command is activated. For example, how often an Animation is played:

The Repeat Every Frame command can be used for actions to be performed repeatedly. For example, to show an object moving across the screen, you can change its horizontal position every frame. The Logic window displays an error message when the Repeat Every Frame command is used incorrectly. For example, if you define Play Animation every frame.

Waiting for Command Completion

Some commands only continue the ENTiTi flow after they are completed. For example, the following shows the Move and Wait command, which does not play the audio until the target object has moved to the specified position, such as when a car drives into a wall and then plays an audio of a crash sound.
Defining Conditions

Condition commands enable you to define conditions that determine the flow (behavior) of your ENTITi. For example, the following shows how the \( A > B \) command can be used:

The following shows how the Is True command can be used:
Defining Random Behavior

The Random Number command provides a variety of options for enabling dynamic ENTITI behavior. The following are a few examples.

Playing Animations, Videos or Audios

You can assign a numeric name to multiple animations, videos or audios and then use the Random Number command to assign the value of the parameter that determines which is played. For example, using the Play Animation command.

Popping Up Items in Random Places

You can define that a monster in a game appears randomly in different places by assigning the Position parameter the value generated by the Random Number command.

Visual Effects

You can create interesting visual effects, such as snow, by making the snowflakes start falling from random places by assigning the Position parameter the value generated by the Random Number command.
This chapter describes a few concepts that may help non-experienced users understand basic 3D terminology.

**Augmented Reality**
Refer to page 8 for an introduction.

**Virtual Reality**
Refer to page 10 for an introduction.

**Digital 3D Space**
The digital 3D space enables the position of a point to be represented by three parameters X, Y and Z. Each of these parameters has a numeric value specifying the distance from a reference point whose position is X=0, Y=0, Z=0. For example, if a point is:

- 1 inch length away from the reference point
- 2 inches height away from the reference point
- 3 inches depth away from the reference point
Then, it is represented as X=1, Y=2, Z=3 or as (1, 2, 3).
ENTiTi – The Core Platform for AR+VR
Now Anyone Can Create!

www.wakingapp.com